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Author Questionnaire 
1. We have marked your project as author-provided footage, meaning you film the video yourself and provide JoVE with the footage to edit. JoVE will not send the videographer. Please confirm that this is correct. 
☐ Correct 
☐ Incorrect 

 2. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or something similar?  Enter Yes or No.  
If a dissection or stereo microscope is required for your protocol, please list all shots from the script that will be visualized using the microscope (shots are indicated with the 3-digit numbers, like 2.1.1, 2.1.2, etc.).
Click here to list microscope shots, using the shot numbers from the protocol section of the video script.

3. Software: Does the part of your protocol being filmed include step-by-step descriptions of software usage?  Enter Yes or No.
If Yes, we will need you to record using screen recording software.
We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS Studio is provided at this link: https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k

As these files are necessary for finalizing your script, please upload all screen captured video files to your project page as soon as possible.

[bookmark: Text5]4. Proposed filming date: To help JoVE process and publish your video in a timely manner, please indicate the proposed date that your group will film here: MM/DD/YYYY

DO NOT use this draft script for filming. Please wait until your script is finalized to begin the filming process. 

When you are ready to submit your video files, please contact our Content Manager, Utkarsh Khare.

To ensure that your script can be filmed in one day, the protocol sections are cumulatively restricted to 55 shots (shots are the 3-digit numbers like 2.1.1, 2.1.2…etc)

Current Protocol Length

Number of Steps:  18
Number of Shots:  34

Introduction 

Answers to these questions will become interview statements that you will deliver on camera.
· Answer the 1st REQUIRED question and at least 2 other questions (1.2 – 1.10) below. Up to 5 interview statements will be included in the video.
· Enter the full name of the author who will deliver the statement.
· If possible, each author should deliver no more than two statements.
· Answer in full sentences, in a style suitable for being spoken aloud.
· Limit the length of each statement to 30 words or fewer.
· Answers will be edited for length, clarity, and consistency with journal style guidelines.

REQUIRED: What is the scope of your research? What questions are you trying to answer? 
1.1. Enter author name.: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What are the most recent developments in your field of research?
1.2. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What technologies are currently used to advance research in your field?
1.3. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What are the current experimental challenges?
1.4. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What significant findings have you established in your field?
1.5. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What research gap are you addressing with your protocol?
1.6. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What advantage does your protocol offer compared to other techniques?
1.7. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
How will your findings advance research in your field?
1.8. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What new scientific questions have your results paved the way for?
1.9. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What research questions will your laboratory focus on in the future?
1.10. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

Ethics Title Card

This research has been approved by the Human Research Ethics Committee of Annaba University 

Protocol  
[bookmark: _Hlk188263998]Please review this section to make sure that it accurately describes your protocol. Use Track Changes when making edits or revisions.
· The two-digit steps (e.g., 2.1., 2.2.) are the narration.  JoVE is responsible for the narration of the protocol and results.
· Red italics are pronunciation guides indicating how the word will be spoken. 
· Filming should take no more than 10 minutes per step. If a step takes more than 10 minutes, prepare the product for that step in advance.
· The three-digit shots (e.g., 2.1.1., 2.2.2.) are the actions that you/your videographer will capture. 

2. Meteorological and Air Quality Data Collection
Demonstrator: Click here to enter name of demonstrator(s)

If the same person is the demonstrator throughout, mention them once here and remove the "Demonstrator" field from the other sections; if the demonstrator changes, retain the field in the respective sections.

2.1. To begin, open spreadsheet software such as Microsoft Excel [1].

2.1.1. WIDE: Talent opening Microsoft Excel on a computer.

2.2. Create a new spreadsheet [1]. Enter the collected data from the participant questionnaires, assigning a unique identifier to each participant and location [2].

2.2.1. SCREEN: To be provided by authors: Clicking on "New Spreadsheet" in Excel.

2.2.2. SCREEN: To be provided by authors: The collected data from the participant questionnaires, assigning a unique identifier to each participant and location.

Authors: Please record the screencapture videos for all the SCREEN shots following our guidelines and upload them along with a summary to your project page: https://review.jove.com/account/file-uploader?src=20562843 

2.3. For the meteorological and air quality data collection, position the device on a tripod at a height of approximately 1.5 meters above ground level in an open area [1].

2.3.1. Talent placing the device securely on a tripod outdoors.

2.4. Turn on the device and initiate data collection [1]. Set the device to record data at 1-hour intervals for a continuous 24-hour period in each area [2].

2.4.1. Talent pressing the power button to turn on the device and initiating the data collection.

2.4.2. SCREEN: To be provided by authors: Setting the recording interval to 1 hour for a continuous 24-hour period.

2.5. After retrieving the logged data at the end of each 24-hour period, download the data to a computer and save it in a secure location [1].

2.5.1. SCREEN: To be provided by authors: Downloading the logged data and saving it into a designated secure folder.

3. Statistical Analysis
Demonstrator: Click here to enter name of demonstrator(s)

3.1. Open the statistical software and click on File, then Open [1]. Select and open the spreadsheet containing the collected data [2].

3.1.1. SCREEN: To be provided by authors: Statistical software being opened and navigating to the File menu, then Open.

3.1.2. SCREEN: To be provided by authors: Selecting and opening the spreadsheet file.

3.2. For descriptive statistics, select the data in the spreadsheet [1], click on Descriptive Statistics, choose the desired statistics such as mean, standard deviation, median, and range, and then click on OK [2].

3.2.1. SCREEN: To be provided by authors: Highlighting data in the spreadsheet.

3.2.2. SCREEN: To be provided by authors: Clicking on Descriptive Statistics option. Selecting mean, standard deviation, median, and range. Clicking on OK to generate descriptive statistics.

3.3. For correlation analyses, select the variables of interest, such as PM2.5 (P-M-two-point-five), AQI (A-Q-I), meteorological factors, and socio-demographic characteristics [1]. Click on Correlation Tests, choose the Pearson correlation method, and click on OK [2].

3.3.1. SCREEN: To be provided by authors: Highlighting PM2.5, AQI, meteorological, and socio-demographic data columns.

3.3.2. SCREEN: To be provided by authors: Clicking on Correlation Tests. Selecting Pearson correlation method. Clicking on OK to execute correlation analysis.

3.4. For multivariate regression, select the dependent variable and independent variables in the spreadsheet [1]. Click on Modeling Data, then Linear Regression [2].

3.4.1. SCREEN: To be provided by authors: Selecting COVID-19 cases and relevant independent variables.

3.4.2. SCREEN: To be provided by authors: Clicking on Modeling Data and then Linear Regression.

3.5. Select Multivariate Regression and then click on OK [1]. Enter the independent variables, including potential confounding factors [2].

3.5.1. SCREEN: To be provided by authors: Choosing Multivariate Regression and clicking OK.

3.5.2. SCREEN: To be provided by authors: Entering independent variables and confounding factors.

4. Geographic Location Map Creation
Demonstrator: Click here to enter name of demonstrator(s)

4.1. Open ArcGIS [1]. Authors: How do you want to pronounce ArcGIS?

4.1.1. SCREEN: To be provided by authors: Launching ArcGIS software on the computer.

4.2. Click on File, then Open [1]. Select and open a new map document [2].

4.2.1. SCREEN: To be provided by authors: Clicking on File and selecting Open.

4.2.2. SCREEN: To be provided by authors: Selecting and opening a new map document.

4.3. Click on Add Data. Select the Algerian base map and click on Add [1].

4.3.1. SCREEN: To be provided by authors: Clicking on Add Data. Selecting Algerian base map and clicking Add.


4.4. To import the coordinate data, click on File, then Add Data, and then Add XY Data [1]. Specify the X Field as longitude and Y Field as latitude, then click on OK [2].

4.4.1. SCREEN: To be provided by authors: Navigating to File > Add Data > Add XY Data.

4.4.2. SCREEN: To be provided by authors: Specifying longitude and latitude fields. Clicking OK.

4.5. To customize the point markers, right-click the new layer, select Properties, then Symbology [1]. Choose appropriate symbols and colors, then click on OK [2].

4.5.1. SCREEN: To be provided by authors: Right-clicking on the new layer and opening Properties. Selecting Symbology.

4.5.2. SCREEN: Choosing symbols and colors. Confirming changes by clicking OK.

4.6. To add a title, click on Insert, then Title [1]. Similarly, to add a legend, click on Insert, then Legend [2]. Include a scale bar by clicking on Insert, then Scale Bar [3]. Similarly include a north arrow [4].

4.6.1. SCREEN: To be provided by authors: Inserting a title onto the map.

4.6.2. SCREEN: To be provided by authors: Inserting a legend.

4.6.3. SCREEN: To be provided by authors: Adding a scale bar.

4.6.4. SCREEN: To be provided by authors: Adding a north arrow.

4.7. Adjust the map layout and zoom level for optimal visualization [1]. Choose appropriate colors, fonts, and symbols [2].

4.7.1. SCREEN: To be provided by authors: Modifying the map layout and adjusting zoom.

4.7.2. SCREEN: To be provided by authors: Editing colors, fonts, and symbols for clarity.

4.8. Finally, click on File, then Export Map [1]. Select the desired output format and resolution, and click on Save [2].

4.8.1. SCREEN: To be provided by authors: Navigating to File and selecting Export Map.

4.8.2. SCREEN: To be provided by authors: Choosing output format and setting resolution. Clicking Save to export the map.












Results
Please review this section to make sure that it accurately reflects your findings.
· This section will not be recorded by the videographer. It only includes the figures/tables from your manuscript (called LAB MEDIA). 
· Use Track Changes when making edits or revisions. Ensure the voiceover length is below 200 words. Current word count: 135.
· Please note that the video cannot include voiceover without an accompanying visual.

5. Representative Results 

5.1. This figure shows the distribution of COVID-19 cases in relation to socio-demographic factors, including chronic diseases, smoking habits, and physical activity levels across the study areas of Annaba province [1]. 
5.1.1. LAB MEDIA: Figure 3.
5.2. Males showed a higher number of COVID-19 cases compared to females in all regions except ELBONI, where the difference was minimal [1]. Authors: In the manuscript, SERAIDI is mentioned instead of ELBONI. Please check the manuscript and Figure 3 and let us know if the voiceover narration should be changed to SERAIDI to match the figure.
5.2.1. LAB MEDIA: Figure 3. Video Editor: Highlight the first two blue bars from the left.
5.3. The 45 to 55 age group had the highest infection rate in most areas, except El Hadjar where the 56 to 65 group was higher [1]. Authors: Please check the manuscript and Figure 3 and let us know if the voiceover narration should be changed to match the figure.
5.3.1. LAB MEDIA: Figure 3. Video Editor: Highlight the bars of 45-55 group and 56-65 group.
5.4. Cases were higher among individuals with type 2 diabetes, hypertension, smokers, and those not engaging in physical activity [1]. Authors: Please check the manuscript and Figure 3 and let us know if the voiceover narration should be changed to match the figure.
5.4.1. LAB MEDIA: Figure 3. Video Editor: Highlight the bars of type 2 diabetes, hypertension, People who smoke (both yes and no), and Physical activity (yes and no).
5.5. Fever and cough were the most common symptoms [1], and illness lasted mainly 5–10 days [2]. Authors: Please check the manuscript and Figure 4 and let us know if the voiceover narration should be changed to match the figure.
5.5.1. LAB MEDIA: Figure 4. Video Editor: Highlight the bars of Fever, Cough, Others.
5.5.2. LAB MEDIA: Figure 4. Video Editor: Highlight the bars of 5-10D.
5.6. PM2.5 concentrations and Air Quality Index values were highest in El Hadjar, with better air quality in Seraïdi and Chetaïbi [1]. Authors: Please check the manuscript and Figure 5 and let us know if the voiceover narration should be changed to match the figure.
5.6.1. LAB MEDIA: Figure 5. Video Editor: Highlight the bars of PM2.5 and AQI.
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